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Introduction

Use this guide as your go-to support resource for troubleshooting and diagnosing common issues related to 
end users, the application server, and the SQL server. The intended audience for this guide is system and 
network administrators, as well as your database administrator. 

Note: Studio Enterprise is in a phased End Of Life Support Cycle. Please refer to our EOL Phased Support Cycle 
for further details.

This guide is not meant to replace your IT team that manages your Studio Enterprise environment, but as a 
support resource to aid in troubleshooting and maintaining a healthy and functional Studio Enterprise 
Environment.

You can use the following resources in conjunction with this guide:

• Studio Enterprise Installation and Configuration Guide
• Studio Enterprise Compatibility Reference
• Best Practices for Bluebeam Studio and Studio Enterprise
• How to upgrade to Studio Enterprise 3.2

To ensure you have and maintain a healthy environment, see the following sections:
• Maintaining a Healthy Environment to ensure your environment meets all recommendations.
• Environmental Checks to ensure your environment is set up for optimal performance.

If your Studio Enterprise environment or your end users experience issues after verifying the above 
environmental checks, our General Troubleshooting section should help resolve most common issues. This 
section includes Studio Outage - General Steps for Resolution for troubleshooting steps and 
recommendations related to a general outage where users are unable to connect.

Note: For the purposes of this document, the term “Studio server” refers to the machine that Studio Enterprise 
is being installed on. The Studio Enterprise server may also be referred to as the “application server”.

Maintaining a Healthy Environment

System Requirements, Recommendations, and Best Practices

Ensure you follow all system and hardware requirements from the Studio Enterprise Installation and Configuration 
Guide. These are strict requirements. If they are not met, Studio Enterprise will likely exhibit undesired behavior and not 
work as designed.

https://support.bluebeam.com/articles/studio-enterprise-eol-announcement/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/best-practices-for-bluebeam-studio/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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Minimum Server CPU and RAM Recommendations

These recommendations depend on several factors and are not guaranteed to fit every environment. Factors such as the 
number of connected users, the number of requests and traffic to and from the server, types of activity occurring, size of 
files and markups, etc. all have effects on performance. The table below illustrates our general recommendations. These 
recommendations assume the following, as seen in the Studio Enterprise Installation and Configuration Guide:

• Dedicated Servers:
o Ensure that SQL Server is being used solely for Studio Enterprise.
o Studio Enterprise and Microsoft SQL Server are installed on separate servers.

• Data transfer speeds between Studio Enterprise and SQL servers are adequate.
• SQL Instance setup to Microsoft's recommendations.
• At least 1 Gigabit connection between SQL and Application server.

Total Registered users, 20% concurrent 1,000 users 2,000 users 4,000 users 6,000 users 8,000 users

Application server CPU 4 CPU 6 CPU 8 CPU 10 CPU 12 CPU

Application server RAM 16 GB RAM 24 GB RAM 32 GB RAM 40 GB RAM 48 GB RAM

SQL Server CPU 4 CPU 6 CPU 8 CPU 10 CPU 12 CPU

SQL Server RAM 32 GB RAM 48 GB RAM 64 GB RAM 80 GB RAM 96 GB RAM

Studio Enterprise Server Recommendations 
You should refer to our Studio Enterprise 3.2 Upgrade Guide for operating system and SQL server recommendations. In 
addition:

• Be sure the server meets Studio Enterprise compatibility and other requirements outlined in the following 
articles:

o Studio Enterprise Installation and Configuration Guide
o Studio Enterprise Compatibility Reference

• Disable Windows Search indexing.
By default, Windows indexing is disabled by Windows Server. However, Windows Search indexing is enabled by 
default. Studio Enterprise manages project files within the Windows file system, and any files created or 
updated while indexing is enabled will invoke the Windows Search indexer to create or update file metadata.

• Use system storage (C: volume) with high IOPS physical drive. 
When a file is posted to a ASP.NET application, the files are temporarily stored, by default, on the C: volume. 
Performance of the drive will impact upload performance. Files beyond a defined threshold are stored within 
the local file system instead of memory. Uploaded PDFs will easily surpass the predefined, default 256KB 
threshold.

• Ensure disk capacity does not Surpass 87.5% (NTFS formatted drives only).
By default, Windows volumes are formatted with NTFS. Behind the scenes, NTFS utilizes a master file table 
(MFT) to string together the file directory tree along with metadata such as creation and update dates. NTFS will 
reserve 12.5% of the volume to be used by the MFT to store that information. If utilization fills up, the MFT and 
new file data will be in contention for the remaining space.

• Consider using a higher performing CPU and memory profile to improve performance.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
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SQL Server Recommendations

Ensure a database administrator (DBA) assists with setting up the SQL environment and configuring it for best practices. 
In addition: 

• Be sure the SQL server meets Studio Enterprise compatibility and other requirements outlined in the following 
articles:

o Studio Enterprise Installation and Configuration Guide
o Studio Enterprise Compatibility Reference
o Supported server operating systems and versions of SQL Server

• Use a dedicated SQL instance.
o Ensure the SQL Server is being used solely for Studio Enterprise.
o Studio Enterprise and Microsoft SQL Server must be installed on separate servers.

• Ensure the Studio database is set to grow unlimited and at minimum 1GB growth rate.
• Reindex the database to mitigate any performance degradation. Try to keep fragmentation below 15%.
• Ensure the Studio database is on a "non-system Storage" (external) high IOPS physical drive.
• Continually monitor disk space to ensure the database is not reaching maximum drive capacity.
• Consider using a higher performing CPU and memory profile to improve performance.
• If needed, run the “exec sp_updatestats” command on both databases, during off-peak hours, to reduce 

latency.
• Ensure regular database maintenance is set up to maintain database health. SQL maintenance is to ensure that 

the database continues performing optimally. These are standard database practices not specific to Studio 
Enterprise that should be performed by your DBA. Our recommendations are:

o Backup – Full Backup of All Databases (daily)
o Backup – Transaction Logs (every 15 minutes)
o Check database integrity (daily)
o Reorganize index (daily)
o Update statistics (daily)
o Rebuild index (weekly) – It’s best to keep fragmentation below 15% if possible.

Environmental Checks

Use the information in this section to investigate Studio Enterprise environment issues, or to ensure you’re running a 
healthy/optimized environment.

General
• Ensure the application server and SQL server meet all requirements listed in these documents.

o Studio Enterprise Compatibility Reference
o Supported SQL versions (SQL Express is not supported for production) 

• Check network bandwidth and usage. Determine whether issues occur if you switch to another network.
• Check CPU/RAM usage on the Studio Enterprise server and SQL servers to ensure resources are sufficient for 

the application and SQL.
• Test to determine which specific action is slow (connecting, Session upload/download, Project 

upload/download/check-out). Perform this test on multiple Revu client systems.
o Are Sessions working as they should? 
o Are Projects working properly?

• Have any changes been made to SQL, Active Directory, Studio Enterprise server, certificates, etc. around the 
time you started receiving reports of the issue? If so, investigate those changes or roll them back if needed.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
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• When users sign into Studio, are they selecting the "Use Windows Authentication" box, domain/user, or using 
an email address?

• Verify the available disk space on both the application server and the SQL server. Be sure the SQL database is 
not full and is free to grow.

o The database and translation log may become full. As a result, no more space is available to write to 
the database, which can cause serious issues.

• What version of Revu is being used? 
Note: Studio Enterprise 3.2 supports Revu 20 and Revu 21.

• Check for pending Windows updates on the servers.

Studio Enterprise Server
• On the Studio Enterprise server, ensure the Microsoft Message Queuing (MSMQ), Bluebeam Studio Job Queue, 

and Bluebeam Studio Services are all running.
o Check Studio Enterprise Administrator > Status and verify an IP address appears in the Hostname field. 

If so, change the hostname to the server FQDN. You must restart the server for the change to take 
effect. 

o Ensure the portal is accessible and an administrator can log in. To open the portal, enter the server 
name in a web browser. 
Example: https://bluebeam.[company].com 
Note: Ensure you are using an “https” URL, because “http” will not work properly.

• Ensure at least .NET 4.5 is installed and in a healthy state. 
o Reinstall or repair .NET if you suspect an issue.
o You can run a Microsoft .NET Framework Repair Tool to see if there are any errors in the .NET 

configuration on the application server. The repair tool can be found here.
• Ensure the IIS version meets compatibility requirements and is running in a healthy state.

o Check IIS to ensure site is running and app pool is running. 
o Perform an IISRESET from an elevated command prompt if there’s an issue.

SQL Server
• Verify the BluebeamCache database exists on the SQL server.
• Verify SQL is running and test the connection to the SQL server via the Bluebeam Studio Enterprise 

Administrator console.
o Open the SQL Server Configuration Manger and ensure the SQL Server service is running and has the 

correct service account.
o The "Windows Authentication" check box requires SE 3.1 or above and Revu 2015 or above.

• Ensure Studio Database maintenance jobs are set up to be run on a regular basis. 
o This includes back up, defrag, and reindexing jobs. 
o These should be setup by the DBA.

https://www.microsoft.com/en-us/download/details.aspx?id=30135
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General Troubleshooting 

Studio Outage - General Steps for Resolution

These general error resolution steps can be used for a variety of issues and will either help resolve the issue or rule out 
many possible causes. 

If the issue is specific to a single user, clearing their cache or resetting their settings may resolve the issue for the user. In 
this case, reference this article to reset settings and reference the Clearing Revu Client Session Cache or the Clearing 
Revu Client Project Cache sections on this document to clear cache. If the issue affects all users, try the following 
solutions: 

• Follow steps found in this support article.
• Test the connection to the Studio Enterprise server from another Revu client. Make note if this issue is user 

specific.
• Test the connection to the SQL server via the Database Connection tab in the Bluebeam Studio Enterprise 

Administrator console on the Studio Enterprise server.
• Try the following solutions to recycle the Bluebeam Studio application and hopefully correct possible issues with 

the SQL server. Ensure the servers in question have valid recent backups. 
o Restart the SQL Server.
o Restart the Studio Enterprise Application Server.
o Restart IIS (Internet Information Services) on the application server (via command line as an admin by 

entering the following: iisreset /restart).
o Restart the Bluebeam Services from the Studio Enterprise Administrator application (Tools > Restart 

Server) - You may need to run this restart twice.
Note: On the Studio application server, please ensure the Microsoft Message Queuing (MSMQ), 
Bluebeam Studio Job Queue, and Bluebeam Studio Service are all running.

WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active users. 
Restarting the server or any Bluebeam Services should be done in a maintenance window to avoid downtime 
for the users. Revu has an Offline mode that will allow them to continue working while the services restart, 
but as a best practice we recommend performing any disruptive changes during non-business hours.

• Check the Studio Enterprise portal in a web browser and verify you can log in.
Note: Be sure to use “https” rather than “http”.

• If these suggestions do not solve the issue, investigate the logs (details below) and correlate issues to possible 
Problem/Solutions found in this package.

• Read through the Environmental Checks section to ensure you are running a healthy/optimized environment.

https://support.bluebeam.com/articles/how-to-back-up-your-revu-2019-settings-stamps/
https://support.bluebeam.com/articles/troubleshooting-studio-enterprise-performance-issues/
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Log Files

When you’re troubleshooting issues in a Studio Enterprise environment, you can use the associated logs as a valuable 
resource. Here are details on where the logs can be found and what to expect. 
Note: Studio Enterprise has advanced into its EOL phase and Bluebeam Support cannot assist with reviewing these log 
files. Please use these log files with your Studio Server administrative team to help with issue resolution.

Log File Locations
• Studio Enterprise logs

o Select Bluebeam Studio Enterprise Administrator Application > File > Show Logs.
o Default location: C:\Windows\Temp\Bluebeam Software
o Also check:

▪ The Bluebeam Studio Administrator log:
C:\Users\[ServiceAccount]\AppData\Local\Temp\Bluebeam Software (aka %temp%) 

▪ C:\Windows\ServiceProfiles\NetworkService\AppData\Local\Temp\Bluebeam Software 
• Studio Enterprise install logs 

o C:\Users\[account]\AppData\Local\Temp 
o Look for logs starting with “Bluebeam_Studio_”

• Check Event Viewer Application and System Logs for errors:
1. Click the Windows Start button.
2. In the search bar, type “Event Viewer”, then press Enter.
3. In the Event Viewer, expand Windows Logs.
4. Check both Application Logs and System Logs for errors.

• Select Revu > Preferences >Admin then click Explore Log Folder to investigate the Revu client logs. The most 
recent Revu.log usually supplies needed context.

Log Contents
The logs below can be found by opening the Studio Enterprise Administrator, then selecting File > Show Logs.

• ActiveDirectoryAdminPortal 
o AD related issues while in the Studio Portal. E.G. LDAP Configuration.
o AD connection issues.

• AutoMapReport 
o AD Automapping information.

• Discovery 
o Related to Revu clients making requests to discover the other endpoints, like Portal and SignalR, in 

Studio.
• HTTPService 

o For the iPad application. Communication and errors related to Revu iPad can be found here.
• JobQueue 

o Emails and other non-real-time processes.
o Project and Session Purge Service.

• Portal 
o Errors that occur while using the Studio Portal.

• SignalR 
o Connection issues for Studio Sessions.
o General SignalR disconnections.
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• StudioServer 
Useful in most circumstances because you learn the following information:

o Connection and general issue Information.
o Possible user login information.
o SignalR disconnections per user.

• WCFService 
o Connection and general issue information.
o May contain user login information.
o File uploads and other non-real-time operations.

• WebAPI 
Useful in most circumstances because you learn the following information:

o Connection and General Issue Information.
o May contain user login information.
o File uploads and other non-real-time operations.

Data Transfer Test — Troubleshooting Performance Issues

You can use the following test to ensure that the Studio Enterprise server and the SQL server have sufficient transfer 
speeds. Testing the transfer speeds from the Studio Enterprise server to an end user would also be beneficial to test. 

Note: Do not perform this test if you use an RDP viewer to remote connect into each machine, because the transfer rate 
over RDP is not a true test of server-to-server transfer speeds.

1. Complete the following steps:
a. Create a file share on the SQL server to which everyone can write.
b. Map a shared drive on the web server to the target share.
c. Copy a large (300+ MB) file from the shared drive on the web server to the share mapped on the SQL 

server.
d. Note the exact file size and the time taken for the transfer.
e. Delete the mapped drive and the share.

2. Calculate data transfer rate:
o Example 1 (GB converted to MB/seconds):
▪ 1.8GB file
▪ 1.8GB = 1800MB

▪ 1 GB = 1000 MB (in decimal). Use decimals when calculating
▪ 1 GB = 1024 MB (in binary)

▪ Transfer time 11 seconds
▪ 1800/11 seconds = 163.63MB/s (Good)

o Example 2 (MB/seconds):
▪ 300MB file
▪ Transfer time 10 minutes (10 minutes * 60 seconds = 600 seconds)
▪ 300/600 seconds = 0.5MB/s (Bad)

o Example 3(MB/minutes): 
▪ 558MB file
▪ Transfer time 1 hour 30 minutes (90 minutes)
▪ 558/90 = 6.2MB/m (Bad)
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Install Issues
Installation Fails as a Result of Incompatible Software

Problem
General installation issues that may be related to software/OS version or compatibility.

Solution
• Ensure you followed procedures in the Studio Enterprise Installation and Configuration Guide during installation 

process.
• For Production use, ensure you are not using SQL Express.
• Be sure SQL and Studio Enterprise are running on separate servers.
• Be sure you are running a supported Windows Server operating system for the application server and the SQL 

server. 
• Be sure you are running a supported version of SQL Server. 
• Ensure all Service Accounts are members of Local Administrators group and their passwords do not expire.
• Check the install logs. 

o C:\Users\[account]\AppData\Local\Temp – Look for logs starting with “Bluebeam_Studio_”.

Windows Authentication for SQL Connection During Installation

Problem
You receive the “Unable to validate the account [Service Account]" error during installation.

Solution
Add the domain account that was being used as the service account for the SQL connection to the Local Administrators 
group on both the SQL server and the application server.

Failed to Start Bluebeam Services During Installation Error

Problem
Bluebeam Services (Bluebeam Studio Job Queue and Bluebeam Studio) do not start during installation.

Solution
Re-issue the site certificate. Install the certificate and ensure it is trusted. The certificate must be installed in the 
Personal certificate store at the local machine level on the Studio Enterprise server. Then re-install Studio Enterprise.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
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Studio Enterprise Server Migration

If you are planning to move your Studio Enterprise server, are only the IP and MAC address changing?
If so, the good news is that the IP and MAC addressing should not impact the license, because the license is registered to 
the server computer name and not tied to hardware addressing.

If you are changing the server hostname, you must ensure you change the name everywhere. This includes the machine 
name, hostname in the Studio Enterprise Administrator, Certificate, URL in IIS, etc. Before you perform this migration, 
we recommend you unregister the Studio Enterprise server. 

1. Open the Bluebeam Studio Enterprise Administrator. 
2. Select Tools > Unregister. 

After you make the necessary changes, use the Studio Enterprise Administrator to register the server and to ensure the 
license is properly applied. 

Connection Issues
General Troubleshooting for Connection Issues

Note: If this troubleshooting solution does not resolve the issue, and there's a connection issue that is not obvious, it 
could be related to a proxy, DNS routing, firewall, or other networking issue that may require your security team to 
packet trace (Wireshark, Fiddler, or Microsoft Message Analyzer) the users’ connections and determine which endpoints 
the Studio connection is going through.

Problem
Users are unable to connect to your Studio Enterprise server with Revu.

Solutions
• Start troubleshooting connection issues by using steps in the following support article: 

https://support.bluebeam.com/articles/troubleshooting-connectivity-issues-with-studio-enterprise/
• Check for hostname misconfiguration:

o Compare machine name, hostname in the Studio Enterprise Administrator, Certificate, URL in IIS, and 
URL shown against endpoints in Revu logs. 

o Check for discrepancies.
• Check for certificate issues:

o Run your web browser as Administrator and open your Studio Enterprise portal URL.
o Check the certificate to verify it is trusted, still valid, and not expired.
o If there is a certificate error check the Certificate Issues section.

• Try the steps found in the General Error Resolution section.

SignalR Error – Sessions Can’t Connect

Problem
Users are unable to connect to Sessions on the Studio Enterprise server.

https://support.bluebeam.com/articles/troubleshooting-connectivity-issues-with-studio-enterprise/
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Solution
Do "SignalR: closed" errors appear in the Revu.log logs for the user or in the SignalR.log on the Studio Enterprise server? 
If so, SignalR is the real-time component necessary for Sessions to function. SignalR protocol must be allowed on 
network communications for Sessions to work properly. The Bluebeam services needed for this to function may be 
down or need a restart.

1. Open the Bluebeam Studio Administrator on the Studio Enterprise Server.
2. Select Tools > Restart Server.

After you restart Bluebeam Services, try to access one of your Sessions again.

WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active users. Restarting the 
server or any Bluebeam Services should be done during a maintenance window to avoid downtime for the users. Revu 
has an Offline mode that allows users to continue working while the services restart, but as a best practice we 
recommend performing any disruptive changes during non-business hours.

You must ensure the "Bluebeam Studio Application Pool" is started in Application Pool section of Internet Information 
Services (IIS) on the Studio Enterprise server.

If these steps don’t resolve the issue, see the Can Connect to Projects but Not Sessions section.

Unknown Error in Revu When Applying Permissions or Attendee Access Settings in Revu

Problem 
When attempting to modify attendee access or permissions settings for Studio Sessions or Projects in Revu, users 
receive an “Unknown Error”. Users may also receive “Unknown Error” when attempting to connect to Studio Enterprise 
server.

• This issue is usually related to HTTP verbs, like GET, PUT, DELETE being blocked on the Studio server.
• As a result of this error, users may be unable to modify Session/Project permissions and uploading markups to 

Sessions may fail.

Solution
• WebDAV can be configured to block or allow verbs. However, WebDAV is not required for the Studio Server to 

work, so you can safely disable it.
• The WebAPI.log Studio log file is where you would see the HTTP verbs being communicated to Studio from the 

Clients. 
• Disable WebDAV.

If you choose to disable WebDAV, we recommend disabling the feature through the Server Manager. Edit 
web.config only if the server requires WebDAV for another reason.

1. Use the Server Manager to uninstall/disable WebDAV as a Server Role. 
2. Restart IIS.
3. Restart Bluebeam Services.

For further information, see the following support article: https://support.bluebeam.com/articles/unknown-error-in-
revu-when-applying-permissions-or-attendee-access-settings-in-revu/. 

https://support.bluebeam.com/articles/unknown-error-in-revu-when-applying-permissions-or-attendee-access-settings-in-revu/
https://support.bluebeam.com/articles/unknown-error-in-revu-when-applying-permissions-or-attendee-access-settings-in-revu/
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TLS Issue – Unable to Connect Using Revu 2016 and Older

Problem
Revu versions 2016 and below are unable to connect to Studio Enterprise, because those versions don’t support TLS 1.2.

Solution
• We recommend upgrading any users with 2016 or below to a newer version.
• If it is not possible to upgrade to a newer version, ensure TLS 1.0 is enabled and ensure that Strong Ciphers are 

not forced.
• We also recommend running a .NET repair tool to see if there any issues with .NET on the Studio Enterprise (SE) 

server. https://www.microsoft.com/en-us/download/details.aspx?id=30135

Studio Server Trial Expired Error in Revu When Trying to Login

Problem
The Studio Enterprise server has been registered and working, and users suddenly receive an error stating, “The 
Bluebeam Studio Server Trial has expired” when attempting to log in.

The JobQueue service places a token in the database every hour that is set to expire in 2 hours. If this service crashes or 
stops, the license can "expire" after 2 hours.

Solutions
Try the following solutions: 

• Restart the Bluebeam Services from the Studio Enterprise Administrator. (Select Tools > Restart Server). You 
may need to select Restart Server a second time.

WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active users. 
Restarting the server or any Bluebeam Services should be done during a maintenance window to avoid 
downtime for the users. Revu has an Offline mode that allows users to continue working while the services 
restart, but as a best practice we recommend performing any disruptive changes during non-business 
hours.

• Re-enter the users’ serial numbers and product keys.
• Set services to automatically recover in the event of a failure. 

1. Open services.msc on the Studio Enterprise server.
2. Right-click the two Bluebeam Services, and go to Properties. 
3. Select the Recovery tab.
4. Configure the failures to Restart the Service. 

https://www.microsoft.com/en-us/download/details.aspx?id=30135
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• For more information, see this support article. 

Users Can Connect to Projects but Not Sessions

Problem
Users can connect to Projects, but are unable to connect to Sessions.

Solutions
Try the following solutions: 

• Ensure users are running Revu 20 or Revu 21.
• Ensure the BluebeamCache database exists on the SQL server. 
• Open the Studio Enterprise Administrator Status to verify the hostname is the FQDN, rather than an IP address. 

If necessary, change the value to the server FQDN. 
Note: You must restart the server for the change to take effect. 

• Reference the SignalR section if the listed solutions don’t help.

Internal Users Can Connect but External Users Cannot

Problem 
Users on the internal network can connect, but users on an external network cannot connect.

Solutions
Try the following solutions: 

• Verify that a proxy is present. If so:
o Ensure URLs are properly routed.
o Ensure proxy re-authentication is disabled for the server URL.

• Ensure firewalls are configured correctly and allow external traffic.
• Ensure a public IP is being used.
• If the external user is using a VPN, ensure it is set up to allow connection to the Studio Enterprise server.

https://support.bluebeam.com/articles/users-receiving-a-studio-server-trial-has-expired-error-when-trying-to-login-through-revu/
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• Check for network issues:
o Ensure the Studio Enterprise server is whitelisted.
o To test whether the issue is related to the network, use Revu to connect to the Studio Enterprise server 

from another network. 
• Check the Active Directory configuration. Verify that the external users are members of the domain. If not, 

ensure Mixed Mode Authentication is used so outside users can create accounts.
• Check for certificate issues.

o If the certificate is self-signed, the end user will need to import certificate into Trusted Root Authority.
o For more information, see the Self Signed Certificates section.

• Check the Revu client and server logs for errors.

Users Can Connect but Are Disconnected After Some Time

Problem
Users can connect to the Studio Enterprise server in Revu, but they are disconnected after a period of time. 

Solution
Disable proxy re-authentication. Revu does not support proxy re-authentication. Ensure the following:

• Present proxies do not require re-authentication with the Revu client. Revu will not resend credentials re-
authentication tokens. 

• Revu is proxy aware if the proxy configuration is recognized as valid, but only on the initial login to Studio. Revu 
uses the proxy set up in the browser and will send those credentials, but it will only send the credentials that 
one time, or when a user reconnects manually.

Active Directory (AD) Integration Issues
LDAP Configuration Guidelines

Problem
Unable to successfully configure LDAP and AD integration configuration in the web portal.

Solutions
Try the following solutions: 

• Reference the AD integration portions of the Studio Enterprise Installation and Configuration Guide for 
guidelines on AD integration.

• Verify the LDAP string is correct.
o Try top-level domain before OUs or CNs to simplify the string. It’s best to let LDAP point to the top-level 

domain (root domain).
o Refer to these example strings:

▪ LDAP://OU=users,DC=company,DC=local
▪ LDAP://dc.company.local/
▪ LDAP://domain-controller/dc=company,dc=local

o The OU that contains the AD Users and SPN account should be children of the LDAP string location. 
▪ The LDAP string should include the OU where all the users who will be logging into Revu are 

located as a child. 
o Do not include AD groups in the LDAP string.
o Verify users have not moved to a different OC or CN.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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o Verify whether you are using the domain name or the name of the domain controller.
▪ You can use the domain name in the connection string, as opposed to the name of a domain 

controller. The difference is that the domain name will resolve to the IP address of any domain 
controller in the domain, which can be both good and bad for the following reasons:
▪ If using the name of the domain, you are not reliant on any single domain controller to 

run for the membership provider to work. However, if the name happens to resolve to 
a domain controller in a remote location with spotty network connectivity, you may 
have problems with the membership provider working.

▪ If you use the name of domain controller and that domain controller goes down, no 
one will be able to connect.

▪ When configuring the LDAP, you are only able to enter one DC (domain controller). 
o You can find more guidance on LDAP Strings from Microsoft. 

• Verify SPN is configured correctly, credentials are valid, and the account can query all necessary fields.
o It’s best to ensure service account passwords are set to never expire.
o Ensure that security principal is a member of the Local Administrators group on the Studio Enterprise 

server.
o Security principal needs Read permission in Active Directory.
o More information on setting up and troubleshooting the SPN can be found below.

• Domain users must have an email address configured to be mapped properly. Check the Mapping Issues section 
for more info.

• Use the Active Directory Diagnostic Scripts to troubleshoot issues.
o Download Link: https://studio.bluebeam.com/share/drbgr2
o Password: SEsupport123
o The “domainconfigdiag” script will check your LDAP connection string, security principal credentials, 

and that Studio can query all the required fields for AD integration to work.
o Instructions included in download.

Service Principal Name (SPN) Configuration Guidelines

Problem
• Unable to configure AD integration.
• Users are not being mapped from AD.
• AD users are unable to log in.
• Security Support Provider Interface (SSPI) authentication failed.
• No SPN is set to authenticate users when using AD and Windows Authentication.

Solution
For the service account to authenticate users seamlessly when Windows Authentication is used, it must be registered to 
the following SPN: 
BLUEBEAM/studio

https://docs.microsoft.com/en-us/windows/win32/adsi/ldap-adspath
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Reference the SQL Authentication vs. Windows Authentication section of the Studio Enterprise Installation and 
Configuration Guide for information about setting up the SPN.

• Use PowerShell to test if account is already set up in Active Directory.
o Run following command in PowerShell: “setspn -q BLUEBEAM/studio -F”

▪ If the account is in AD, the command should return “Existing SPN Found” and the name of the 
SPN.

▪ If the account is not in AD, the command should return “Not Found”.
o Ensure the service account used for SPN is a member of the Local Administrators group on the SE 

server.
o Ensure the SPN account has a password that does not expire.

• Use PowerShell to set SPN in Active Directory.
o Ensure the account you’re using for this task is a member of the Domain Admins group.
o Run the following command in PowerShell, adjusting the command for the domain and the service 

account:
“setspn -S BLUEBEAM/studio DOMAIN\SERVICEACCOUNT”

• You can check which account is used as the SPN by logging into the Studio Enterprise portal in a web browser 
and looking under the AD Integration page. You may need to reset the Security Principal password.

o Ensure the SPN exists in AD.
o Determine if the password is expired. If so, you must reset the password.

• Use PowerShell to check for duplicate SPNs by running the following command:
“setspn -x”

• Use PowerShell to unregister SPN by running the following command: 
“setspn -D BLUEBEAM/studio DOMAIN\SERVICEACCOUNT”

AD Group Requirements

Problem
AD groups are configured using the AD Group option in the AD Integration page of the Studio Enterprise web portal. If 
you chose to restrict Studio Enterprise accounts by AD group, reference the Solution section below to troubleshoot 
issues.

Note: Using Groups can be inefficient when there are many AD objects. If you experience any AD query timeout issues, 
it's best not to use Groups.

Solutions
Try the following solutions: 

• Check the following AD Group Properties:
o Security Group (Supported)
o Distribution Groups (Not supported)
o The Scope must be set to "Global"

• Users must be direct members of a Security group.
• The SPN must be a direct member of the Security group to authenticate group members.
• You cannot use default AD groups like "Domain Users".
• Users must have an email address configured.
• Not following these requirements may result in the following:

o Users appear under AD Manage Users > All Users but cannot log in.
o Existing studio users don't auto-map. 
o Users can't log in with Windows Authentication/AD Credentials.

• When making group member changes, you should not have to restart to see the changes or additions; the 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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changes should automatically appear. Ensure that these users are direct members of the AD group. If a user is in 
a subgroup of the AD group, they will not appear in the AD Manage Users Query and may not be able to log in.

• Ensure the user has a login name under both “User Logon Name” and “User Logon Name (pre-Windows 2000)” 
in AD. 

Mapping Issues

Problem
Users are unable to log into the Studio Enterprise server from the Revu client. Certain AD users are not being mapped 
successfully. The AD user is not found on the AD Manage User page in the Studio Enterprise web portal.

Solutions
• Verify that all the required fields in AD contain data and can be queried. All these values are mandatory.

• Are you using AD Groups in the AD Integration options (This can be found in the Studio Enterprise web portal)?
o Login can be slow with lots of groups and potentially timeout.
o Simplify this configuration if this is the case.
o If using AD Groups, ensure users are members.

• Ensure the AD users are included as a child of the LDAP string.
o Update the LDAP string to point at the top-level domain (root).
o  Try a few different tests, moving users to a different OU, creating new users, etc. to see if anything 

helps.
• Ensure the user is a member of Domain Users.
• If you have Windows Authentication enabled for the service account and can manually enter AD credentials but 

can’t login with check box, the SPN may need to be investigated. Check the SPN section to troubleshoot the SPN 
configuration.

• Ensure the server you are connecting to is not one of our cloud servers (studio.bluebeam.com or 
bluebeamstudio.co.uk).
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• After verifying all the above, select Auto-Map Users in the AD Integration tab of the Studio Enterprise web 
portal to map users. 

Users Can No Longer Log in with AD Credentials

Problem
Users who were previously able to log in with AD credentials are no longer able to do so.

Solutions
• If you’re using Mixed Mode Credentials, do regular Studio (non-AD) accounts work?
• Is the account password valid? 

o Check with a network administrator to ensure your AD account is active and the password is correct.
o If unsure, reference the Reset Studio Account Password section.

• If the SPN password has changed, check the SPN section to troubleshoot the SPN configuration.
• Check logs from the Revu client and server.
• Verify the LDAP string. Refer to LDAP Configuration Guidelines for details.

Active Directory Error Messages in Logs

Problem
The main cause of the error below is the limitations of directory searches done on the Manage AD Users page within the 
Studio Portal.

ERROR - Bluebeam.Studio.AdminPortal.Core.DomainAccountRepository - 
System.Runtime.InteropServices.COMException (0x8007202C): The server does not support the requested 
critical extension.

Information on Issue
The issue is caused by the Directory Searcher components within the Microsoft libraries that Bluebeam leverages to 
search for users that exist under the configured LDAP path. The issue occurs when more than 2000 users are listed 
under the configured path, which is near the default cutoff for the maximum number of results that AD will return for 
any query. This is a Microsoft limitation, so we are unable to provide specific remediation steps, but this article details 
possible solutions.

WARNING: We don’t recommend increasing the search buffer size, because it could cause unforeseen performance 
issues for the AD infrastructure.
Problem
The Security Principal is no longer valid, and the error below displays.

ERROR - Bluebeam.Studio.AdminPortal.Core.DomainAccountRepository - Please check that the configured 
Studio security principal is still valid. The principal may no longer exist, or the password may have expired.

Solution
In some cases, this error does not affect functionality and is triggered by the “DomainAccountRepository” error above. If 
this is not related to the “DomainAccountRepository” error and users are unable to connect with AD accounts, the SPN 
may be misconfigured. In this case check the above SPN section to troubleshoot the SPN configuration.

https://www.itprotoday.com/active-directory/conquer-active-directory-s-built-limits
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AD User is Not Found on The AD Manage User Page in Studio Portal

Problem
Certain AD users are not being mapped successfully. The AD user is not found on the AD Manage User page in the Studio 
portal.

Solutions
• Ensure the AD users are included as a child of the LDAP string.
• Ensure the user has an email address in their AD User Object. 
• Try updating the LDAP string to point at the top-level domain (root)
• Check the Mapping Issues section for more details.

AD User Left the Company and was Rehired

Problem
If a user was deleted from AD, the user account is still active in the Studio Enterprise environment. If a user has been 
subsequently rehired and they need an account, they will need to remap it.

Solution 
1. Log into the Studio Enterprise portal with an Administrator account. 
2. Open the AD Manage Users window. 
3. Find the user in question and select Unmap User.
4. Have the user try to log into Studio Enterprise again.

Note: If the user account in the AD Manage Users window doesn’t have an email listed and the “Unmap User" option 
isn’t available, go into the Studio Portal, locate the user account and click "Update Profile". This action may be 
required to refresh the user account and get it mapped, so we can perform the procedure and properly remap the 
account.

If this procedure doesn’t resolve the issue, you can delete the user from the database directly.

WARNING:  These SQL changes can possibility cause data loss or database corruption. An experienced DBA should be 
involved for any of these changes. Back up the database prior to making any changes.

▪ Execute the SQL query " delete from T_ActiveDirectoryUser where DomainEmail = 'user@company.com' "
▪ Refresh the web portal and try to remap the user. 
▪ As a last resort, try to delete the user from the T_User table. When doing so, you will get errors from other 

tables that have database constraints against the user. You will need to go through and delete the user from 
every table that shows a constraint before you can finally delete the user from T_User table.

Reset Studio Enterprise to Studio Credentials Only

Problem
Studio Enterprise gets stuck in an AD configuration that is corrupted or no longer working.

Solution
You may need to force the configuration back to its default. To perform this action, you must run SQL scripts to change 
back to Studio Credentials Only. 
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This solution may also be useful for customers who can no longer log into the Portal because their LDAP settings are 
misconfigured, or they don’t know the password for the administrator account. 

Use the Reset Studio Credentials Script in this circumstance. 

WARNING: Use this script as a last resort. This script will delete all AD configurations to unmap all users, configuration 
settings, and reset it to Studio credentials. If the users’ email addresses have not changed, their Sessions will still be 
associated. Sessions are correlated by email address. After AD is re-integrated, users will get remapped as soon as they 
log in.

Unable to Log in with AD 

Problem
Unable to log in with Active Directory and the log shows an Object Reference error when logging into Studio. 
‘System.ServiceModel.Diagnostics.TraceUtility’ - ‘AccountCreateResponseDto’ Errors.

Receiving ‘System.ServiceModel.Diagnostics.TraceUtility’  errors. Finding errors in logs and event viewer related to .NET. 
Exception similar to the following:
System.TypeInitializationException: The type initializer for ‘System.ServiceModel.Diagnostics.TraceUtility’ threw an exception. - 

System.Configuration.ConfigurationErrorsException: Configuration system failed to initialize - System.Configuration.ConfigurationErrorsException: The ‘configuration’ start tag on 

line 12 position 2 does not match the end tag of ‘system.data’. Line 172, position 7. (C:\Windows\Microsoft.NET\Framework64\v4.0.30319\Config\machine.config line 172) - 

System.Xml.XmlException: The ‘configuration’ start tag on line 12 position 2 does not match the end tag of ‘system.data’. Line 172, position 7.

You may also receive the following error when trying to create a New Studio Account.

Solutions
These issues are related to an unhealthy .NET state on the Studio Enterprise server.

• Use a .NET repair tool to find issues with .NET on the Studio Enterprise server that can be repaired. 
• If repairs do not help, .NET may need to be reinstalled. 

a. Uninstall Studio Enterprise.
b. Use the Server Manager on the Application server to remove .NET:

i. Remove Roles and Features on the web server — Select the version of .NET to uninstall.
ii. Restart the server.

WARNING: This leaves the Server core installed without a GUI. Only the Admin CMD Prompt is 
available.

c. Reinstall the GUI — https://social.technet.microsoft.com/wiki/contents/articles/51720.windows-
server-troubleshooting-procedure-to-recover-gui.aspx.

d. Use the Server Manage to re-install .NET:
i. Add Roles and Features - Select the version of .NET to install.

ii. Restart the server.
e. Reinstall Studio Enterprise. 

https://www.microsoft.com/en-us/download/details.aspx?id=30135
https://social.technet.microsoft.com/wiki/contents/articles/51720.windows-server-troubleshooting-procedure-to-recover-gui.aspx
https://social.technet.microsoft.com/wiki/contents/articles/51720.windows-server-troubleshooting-procedure-to-recover-gui.aspx
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“Please map at least one studio admin account to a domain user that exists…”

Problem
You received the “Please map at least one studio admin account to a domain user that exists under [LDAP String] to 
avoid a system logout” error when setting up Active Directory integration.

Solution
This error is related to setting up with Active Directory Credentials Only. We recommend initially setting up this 
configuration with Mixed Mode Credentials. Doing so allows you to test the AD integration after you set it up and verify 
everything works as desired. If AD integration is initially set to Credentials Only, you risk not being able to access the 
portal with your current non-AD Studio Administrator Account.

Set up integration with Mixed Mode Credentials and set some of the users mapped from AD as Administrators in the 
portal. With Mixed Mode on, perform the following steps: 

1. Go to the Users panel and select the AD users you want to make a Portal Administrator.
2. Under User Role, select the Administrator. 
3. Select Update profile. 

We also recommend setting a few accounts to have the Administrator value to ensure there is a backup if you lose 
credentials for the main admin account.

Certificate Issues

Certificate Change 

Information about certificates can be found in the Studio Enterprise Installation and Configuration Guide. When you 
obtain the replacement certificate, it must be installed in the Personal Store at the local machine level on the Studio 
Enterprise server.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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After the certificate is installed in the Personal Store, follow these steps to change the certificate:

1. Open the Bluebeam Studio Enterprise Administrator on the Studio Enterprise server.
2. In the Status tab, ensure the hostname matches the name on the certificate.
3. Select the Certificate Configuration tab on the left.
4. Select Change Certificate and select the new certificate. 
5. Select OK.
6. Select Apply. 
7. When prompted to restart services, select Yes to restart Studio Enterprise Services and apply certificate 

changes.
8. In most cases you will also need to change the certificate in IIS (Internet Information Services) to ensure you can 

connect to the web portal. Open IIS on the Studio Enterprise server.
9. Find the Bluebeam Studio Server site. Right-click and select Edit Bindings. 
10. Select the https binding and select Edit.
11. Change the SSL certificate to the new certificate being used by the Studio Enterprise server. 
12. Select OK.

Note: If you are unable to connect to the web portal after the SSL change, you may need to ensure that the IP 
address is assigned in the https bindings.

13. Press OK. 
14. As an administrator, use the following command line to restart IIS on the Studio Enterprise server:

iisreset /restart
15. Test connectivity to the Studio Enterprise server via both Revu and a web browser.

WARNING: Performing these actions will result in the loss of connectivity for active users. If this is a concern, schedule 
downtime to perform the certificate change.

Can't Log in, Can't Access Portal, and https://localhost Fails to Load Anything

Problem
Users are unable to access the Studio Enterprise server from the Revu client, they can’t access Studio Enterprise portal 
from a web browser, and https://localhost fails to load on the Studio Enterprise server.

Solution
Check the following:

• Check Certificate Bindings in IIS.
1. Open IIS.
2. Select Bluebeam Studio Server.
3. Select Bindings…. 
4. Ensure Site Binding is set for port 443.
5. Ensure the IP address is assigned.
6. Ensure the SSL certificate matches the certificate used in Bluebeam Studio Administrator.
7. As an administrator, use the following command line to restart IIS on the Studio Enterprise server:

iisreset /restart
• The certificate may need to be changed if it is invalid. If you need to change the certificate, see the Certificate 

Change section.
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• IIS may be corrupt. If the solutions above don’t help, try the following: 
1. Uninstall Studio Enterprise, 
2. Uninstall IIS components from Server Manager.
3. Reboot the server.
4. Re-install (reselect) IIS components from Server Manager 

WARNING: Do not select WebDAV.
5. Re-install Studio Enterprise.

Self-Signed Certificate 

Problem
Users are unable to connect to Studio Enterprise. A certificate error appears, or the certificate shown when the portal is 
used is invalid. If there is an issue with the certificate, the Revu client log would show errors like this:

Unable to retrieve discovery information for the server.

The underlying connection was closed: Could not establish trust relationship for the SSL/TLS secure channel.

System.Net.WebException: The underlying connection was closed: Could not establish trust relationship for the 
SSL/TLS secure channel. ---> System.Security.Authentication.AuthenticationException: The remote certificate is 
invalid according to the validation procedure.

The issue could also result in the following error message:
A task was canceled.

Solution
The problem is most likely that the self-signed certificate Studio Enterprise is using, is not installed on the end user’s 
computer. As a result, Revu won’t connect due to security errors that should appear in the Revu logs.

• The first thing to check is that you do not use http:\\ when entering the server name into Revu, because this can 
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cause an issue.
• Next, open your web browser and visit the Studio web page (https:\\servername). When the certificate error 

appears:
1. Choose to view the error. 
2. When prompted, choose to install the certificate. 
3. In the Select Certificate Store dialog, place the certificate in the Local Computer folder under Trusted Root 

Certification Authorities. 
4. Select Show physical stores.
This will ensure that the certificate is trusted for all users on the computer.

An SSL belonging to a Trusted Root Certification Authority (CA), would automatically authenticate a user when 
the Revu client connects to the server, so you may be using a self-signed certificate since it needs to be 
installed. Check to see if the name on the certificate matches the machine name, which should match the host 
name in the Studio Administrator. This is what you'd need to use as the URL in Revu if there is a discrepancy 
anywhere Revu would fail to connect with security errors. Some more details on Certificate naming can be 
found below.

Certificate naming:
The self-signed certificate name must match the hostname of the Studio server. In the Studio Administrator, click Status 
and verify the hostname matches the certificate name.

If the Studio server is not on a domain, but the certificate was issued by a domain address, remove the domain and 
recreate the certificate. 
Note: The certificate name must match the server hostname:
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If the name in the Machine field includes “.com”, but this server is not on a domain, remove “.com” from this field and 
create a new certificate.

Hostname: EXAMPLE.DOMAIN.LOCAL                                               Certificate viewed from Certificate Configuration page

iPad Users Can’t Connect

Problem
Revu for iPad users can’t connect to the Studio Enterprise server, but Revu for Windows machines can.

Solution
See https://support.bluebeam.com/articles/can-revu-and-vu-ipad-connect-to-studio-enterprise/.

https://support.bluebeam.com/articles/can-revu-and-vu-ipad-connect-to-studio-enterprise/
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Studio Portal Issues
Change Password Tab Missing from Studio Portal for Some Users

Problem 
The Change Password tab is missing from Studio Portal for some users.

Solution
We hide the Change Password tab for users created via AD. If a user logs in via Revu for the first time using their AD 
credentials, a Studio user with no password is created and cannot be changed. We do the same thing for Studio users 
who are mapped to AD accounts. AD users must change their passwords via AD.

Error: “Enter a valid host name" Appears When Attempting to Open Studio Enterprise 
Portal in Web Browser

Problem
The error, “Enter a valid host name" appears when attempting to open the Studio Enterprise portal in a web browser.

Solution
This issue is a result of using an underscore character in the server hostname while configuring the server. To resolve the 
issue, remove the underscore character from the server hostname and all references to it. Compare the machine name, 
hostname in the Studio Enterprise Administrator, certificate, and URL in IIS to verify they do not include the character.

Establishing a New Studio Administrator if the Original Administrator Password is Lost

Problem
You’re unable to log into the Studio Enterprise portal as an administrator. This issue could be the result of an 
administrator leaving the company with no back up administrator or the administrator losing their password.

Solution
If you have a user with administrator access, you can assign the administrator role another user. For more information, 
see the User Administration and Reporting section of this document. If the administrator has lost their password, see 
the Reset Password section of this document for more information.

If using AD Credentials Only, you may need to reset the credential type to Studio Accounts to allow you access. See the 
Reset Studio Enterprise to Studio Credentials Only section for further details. In most circumstances, we recommend 
working with IT to gain access to the AD account that previously had Studio Enterprise portal administrator permissions 
and logging in with those credentials.

If no users have administrator permissions to the Studio Portal, you'll need to edit a user directly in the database and 
grant them access.

1. Use a current, non-AD Studio account or create a new Studio account that is not mapped to AD. This account 
will be granted administrator rights. Use the Revu login dialog, and reference the Creating User Accounts 
section for steps to create an account. 

2. Log into the Portal with that user’s Studio account.
3. With the help of a database administrator, run the following command on the BluebeamStudio database:
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--Script to set user account as admin. Replace email address on line 5 with desired email address.
USE BluebeamStudio
GO

DECLARE @myEmail nvarchar(max) = 'sample@email.com'; --Enter email address here. Replace 
"sample@email.com"

DECLARE @myUserID INT
SELECT @myUserID =  [UserID] FROM T_User WHERE Email = @myEmail

PRINT CONCAT('Email: ',@myEmail)
PRINT CONCAT('UserID: ',@myUserID)

UPDATE T_User
SET UserStatus=0, ServerAccess='True'
WHERE Email=@myEmail

if exists(SELECT * from T_UserRole where UserID=@myUserID)            
BEGIN            
 update T_UserRole set RoleID=1 where UserID=@myUserID  
End                    
else            
begin  
insert into T_UserRole values(1,@myUserID)  
end

4. Update the email address on line 5 with the email address for the account that needs to be an administrator. 
5. After running the script, log into the portal to verify administrator access was granted.

Studio Sessions Markups are Not Updating in Real Time

Problem
Multiple users are connected to a Studio Session. Each user can only see updates to markups they place but not 
markups of other users. 

Error Sample (multiple instances of the same error found in StudioServer.log, located in 
C:\Users\WindowsUserAccount\AppData\Local\Temp\Bluebeam Software):
"System.Exception: Certificate Error. Could not find the certificate with the hash string:"

Solutions
Try the following solutions: 

1. Launch the Studio Enterprise Administrator on the application server. 
2. Go to Certificate Configuration.
3. Click View Certificate 

Note: In some instances, Studio Enterprise Administrator will not indicate a problem with the certificate, but the 
issue is present. In other instances, the message "Certificate Not Found" appears.
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4. Select Change Certificate.
5. If more than one certificate is listed, determine the correct one (the one with the latest dates, etc.), and ensure 

the check box is selected as shown below. 

6. Select OK.
7. Restart the Studio Enterprise instance by selecting Administrator > Tools > Restart Server.
8. In most cases, you should also reboot the web server. 

a. Log into the web server as an administrator.
b. Use the command line to enter the following command: 

iisreset /restart 
Note: This action should be performed during a maintenance window (with no users connected to Studio). 

9. When services are back online, perform tests to verify the issues are no longer present.

If this solution does not resolve the issue, try clearing the Session cache as described in Clearing Revu Client Session 
Cache.
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Studio Web Portal Prompts Users to select a Client Certificate

Problem
The Studio web portal prompts users to select a client certificate.

Solution
This issue is related to the IIS configuration. To prevent this prompt:

1. Open IIS on the Studio Enterprise server. 
2. Select the Bluebeam Studio site and double-click SSL Settings.
3. Deselect Require
4. Set Client Certificates to Ignore. 
5. Apply the settings. 

Perform an IISRESET after this change.

Profile Information is Blank in Studio Portal 

Problem 
If the user’s profile information is blank in the Studio web portal, the issue is likely related to an issue with their email 
address. If a Studio account was created with an email address containing an apostrophe or another invalid character, 
their user profile may show up blank in the web portal. 

Solution

You can use Studio Enterprise with an email address that includes an apostrophe, but administering the account through 
the portal will not work as expected. We highly recommend not using email addresses that include apostrophes or other 
special characters. 

If you do use an email of this type and you need to access the functionality in the portal for the user, ask your DBA for 
help to remove the apostrophe from user’s email value in the T_User table of the database. You can then access the 
user in the Studio Enterprise portal and make the needed changes. After you make the changes in the Studio Enterprise 
portal, the DBA can revert the email address in the T_User table back, after which the user will once again display the 
blank information in the portal.

User is Connected to the Wrong Session/Project

Problem
A user logs into Studio and selects a Session or Project ID in the Revu Studio panel, but the user is connected to a 
different Session or Project ID.

Solution
Making a profile change causes the Studio database to rebuild the users Profile and usually fixes the above issue.

1. Log into the Studio Portal as an administrator and find the user’s profile. 
2. Make any change to their profile, such as a change to their User Role, and select Update Profile. 
3. Revert the change and select Update Profile again. 
4. Ask the user to try connecting to their Session or Project and verify they are connected to the proper 

Session/Project ID. 
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If this procedure doesn’t resolve the issue, check if the Technician Role is selected in the user’s profile. If so, deselect the 
Technician Role for the user and select Update Profile.

Note: Users with the Technical Role selected in their profiles can join Sessions they are not invited to. However, they are 
not able to access Session files.

Administrator Tasks
How to Use the Session Status and Properties Panel in the Web Portal

If your user account has the Administrator role, you can use the web portal to perform administrative tasks on the 
Studio Enterprise server. 
Log into the web portal for the Studio Enterprise server with an administrator account. 
Select Sessions on the left navigation. 

From the Sessions page, you can search through the Sessions to find any that meet your criteria or sort by a specific 
column. In the above image you can see the Sessions are being sorted by Status.

If you select a Session, you can access several tabs with potentially useful information about the Session. If you wish to 
change the Status of a Session, select the new Status in the Profile tab and select Update data. We recommend that you 
download any documents you might need from a Session prior to changing the Status to anything other than “Active”.
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You can also use the Return Session Status Script to query the Session status directly from the Studio Enterprise server 
database. 

User Administration and Reporting

If a user account is set to Suspended in the Studio Portal, that user can no longer access Studio. This setting is useful for 
any users who are no longer employed, or for project partners who no longer require access. To determine if a user is 
suspended: 

1. Use an administrator account to log into the Studio Enterprise web portal.
2. In the left navigation, select Users. 
3. View the User Status column to verify if the user is Suspended.

To change the Suspended Status:
1. Select or search for the user.
2. Select the user’s profile to see “Server Access”. 

o If it is Allowed, the user is not Suspended. 
o If it is Restricted, the user is Suspended.

Users with the Administrator role have access to Administer the server via the web portal. The Studio Enterprise Install 
and Config Guide details the different role behaviors. Only Administrators will have access to all the control options in 
the portal. All other users will only have access to the My Sessions and My Profile Tabs.

There is no reporting feature for the user list, though you can select them all and copy them into an excel sheet. This will 
just take some formatting.

You can also use the SQL database to collect this information. For more information, see the Return User Role 
Information Script. 

See this support article for more information on User Roles. 

Suspended Account – Reference if you wish to Delete or Remove a User
There is no official/supported/recommended way to delete a user from Studio Enterprise. If a user needs to be 
removed, instead set Server Access to Restricted as detailed above. More information on this process can be found on 
our support article How to revoke user access for Studio Enterprise.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/what-are-the-roles-for-user-accounts-in-the-studio-portal-used-for/
https://support.bluebeam.com/articles/how-can-i-prevent-an-existing-user-from-accessing-the-server-anymore/
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Reactivate Project

Use the following procedure to reactivate deleted Projects through the Studio Portal:
1. Enter your company's Studio Enterprise server into a browser

Example: https://bluebeam.[company].com
2. Sign in with a Studio account with Administrator permissions. 
3. Search for the Project or Project item you want to reactivate. 
4. In the left navigation select Project Undelete.

For more information on this process, see the Project Undelete Page section of the Install and Config Guide.

Restricting Domains / Restricting User Permissions

You can use the Server Permissions page in the Studio Enterprise portal to restrict access to your Studio Enterprise 
server in the Studio Enterprise portal. These configuration details can be found in the Studio Enterprise Installation and 
Configuration Guide.

The method described below only allows you to deny specific domains, but it will not allow you to deny all domains 
other than the ones you allow. For example, if you specify both @domain1.com and @domain2.com as allowed 
domains, all other domains would still be accessible. There is no way to use a wildcard to deny all possible domains, 
instead any domain you want to deny will be allowed until it is entered here. 

Furthermore, if you set the Studio Users Default to Deny, but have a Domain set to Allow, that domain will still have new 
accounts created with Deny permissions, as it will take the most restrictive permissions. Here is an image depicting this 
setting.

If “Studio Users Default” is set to “Deny”, anyone who creates a new account will have their values set to “Deny”. If you 
do not have many new users, this may be a path forward. You could restrict the whole server and then you will need to 
manually approve new users’ access. With this configuration, you would then go to the “Users” panel and change their 
access from “Restricted” to “Allowed”. 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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SQL Server Issues

Database Install Fails

Problem
Database creation fails during Studio Enterprise installation.

Solution
Check the following: 

• Check permissions on the Setup account. Ensure the service account has the following required permissions:
o dbcreator – to create and configure the database
o securityadmin (during creation only) – to configure the service account to run stored procedures and 

gain access to the database
o serveradmin 
o DatabaseMailUserRole
o Ensure Service Accounts are members of local Administrator group.
o More information can be found in the Studio Enterprise Install and Configuration Guide.

• Check Install Logs. 
o C:\Users\[account]\AppData\Local\Temp – Look for logs starting with “Bluebeam_Studio_”.
o If you see errors related to “Failed to verify signature of payload” and “Failed authenticode verification 

of payload”, verify the certificate is trusted.
• If installing SQL 2016, SQL 2019, or SQL 2022, ensure you use the Studio Enterprise 3.2 build. For more 

information, see How to upgrade to Studio Enterprise 3.2.

SQL Server Migration

When migrating to a new SQL server, your DBA must be involved and guiding most of the process. Your DBA will be able 
to perform most of the migration in line with their regular process, combined with our general best practices and 
recommendations, as seen in How to upgrade to Studio Enterprise 3.2.

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
https://support.bluebeam.com/articles/upgrade-studio-enterprise-3-2/
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SQL Queries
Check Fragmentation Script 
Keep fragmentation below 15% if possible. The script below can help verify the fragmentation on important indexes. 
With that information, you can change the maintenance routine as needed. 

--This query will return fragmentation values for Bluebeam Studio Indexes
USE BluebeamStudio
GO

SELECT dbtables.[name] as 'Table',
dbindexes.[name] as 'Index', dbindexes.type_desc,
indexstats.avg_fragmentation_in_percent
FROM sys.dm_db_index_physical_stats (DB_ID(), NULL, NULL, NULL, NULL) AS indexstats
INNER JOIN sys.tables dbtables on dbtables.[object_id] = indexstats.[object_id]
INNER JOIN sys.schemas dbschemas on dbtables.[schema_id] = dbschemas.[schema_id]
INNER JOIN sys.indexes AS dbindexes ON dbindexes.[object_id] = indexstats.[object_id]
AND indexstats.index_id = dbindexes.index_id
WHERE indexstats.database_id = DB_ID()

Active Connections Script
The max pool connection size for the Studio server is set to 100 by default. The query below will return all active 
connection values for the database. If this query shows at/or above 100 for the ".Net SQLClient Data Provider" row, you 
may need the Studio Enterprise Performance Patch. 

Note: If you’re using Studio Enterprise 3.2, you don’t need this script. The performance patch is built in and allows for 
1024 connections. 

--This query will return active connection values for Bluebeam Studio
USE BluebeamStudio
GO
SELECT
getdate() [date],
s.host_name,
s.program_name,
s.login_name,
COUNT(s.session_id)
FROM sys.dm_exec_sessions s
INNER JOIN sys.dm_exec_connections c
ON s.session_id = C.session_id
WHERE s.is_user_process = 1
group by s.program_name, s.login_name, s.host_name
ORDER BY COUNT(s.session_id) DESC

Note: This is a real-time query that should be run during peak usage hours or during times when users are reporting 
performance issues.
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Reset Studio Credentials Script
Reference the Reset Studio Enterprise to Studio Credentials Only section for more information about why you may need 
to run this script. 

--This SQL script will delete all AD Integration Configurations and set it back to Studio 
Credentials Only mode
USE BluebeamStudio
GO
DELETE FROM T_ActiveDirectoryUser
DELETE FROM T_DomainGroup
DELETE FROM T_DomainConfiguration
UPDATE T_Configuration
SET VALUE = 'StudioCredentialsOnly'
WHERE NAME = 'AuthenticationMode'

WARNING:  These SQL changes can possibly cause data loss or database corruption. An experienced DBA should be 
involved for any of these changes. Back up the database prior to making any changes.

Return Session Status Script
The following query can return the session status for you. Use this script if you want to verify the session status with 
more precision than what is found in the Session Status and Properties Panel – Portal section.

--Find Session Status
USE BluebeamStudio
GO
SELECT PublicID, Name, Created, LastConnected, Status, Deleted
FROM T_Session
WHERE PublicID = 'xxx-xxx-xxx'; --ENTER Session ID 

Session Status Values
0 = Active
1 = Suspended
2 = Archived
3 = Finalizing 
4 = Deleted
5 = Purged
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Return User Role Information Script
The following query will return user information and the roles and ServerAccess value that allow you to verify whether 
they are Suspended. If needed, you can use the SELECT function to add columns. If you run this script, there will be a 
separate entry for each different role. 

--Return User Role Information
USE BluebeamStudio
GO
SELECT T_User.UserID, T_UserRole.RoleID, T_User.Email, T_User.DefaultName, 
T_User.ServerAccess, T_User.Created
FROM T_User
LEFT JOIN T_UserRole
ON T_User.UserID = T_UserRole.UserID;

Role Legend
1 = Administrator
2 = User (Deprecated – Not Used)
3 = Technician 
WARNING: This account should be avoided in most circumstances. When Technician is selected, you are unable to 
open documents in a Sessions. You can join a Session but when you try and open a file it will briefly pop up, but 
then disappear. All other technician features work as designed. For more information see the User is Connected to 
the Wrong Session/Project section. 
4 = Service
Null - Traditional access (Note: Null is the default Standard User value if no other user option is selected)

Server Access Legend — See the User Administration and Reporting section for more information about the Suspended 
value.
0 = Suspended (Server Access set to Restricted)
1 = Active (Server Access set to Allowed)

Revu Client Issues

Clearing Revu Client Session Cache

Several circumstances exist in which a user’s Session cache may become corrupted and need to be cleared. Use the 
steps below to clear the Session cache.

Within Revu, access the Session in question and click the Pending tab to view any markups. If you see pending markups, 
make sure your internet connection is online, so you can upload the markups. 
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If the Pending tab is empty, log out of Studio and go to the following path on your computer, depending on your version:

Session Cache:
%localappdata%\Bluebeam\Sessions (v2017)
%localappdata%\Revu\2018\Sessions (v2018)
%localappdata%\Revu\data\Sessions (v2019 and above)

Once you’re there: 
1. Go to the folder that bears the Studio Enterprise server name (if your Session is currently in 

studio.bluebeam.com, go to that folder).
2. Rename the folder that shows the Session ID in question (You can enter “old” at the end of the new folder 

name). 
3. Restart Revu. 
4. Log back into Studio. 
5. Return to the Session in question and see if the issue is resolved.

Note: Once you log back into the Session, this cached folder is recreated with the data from the Session hosted on the 
Studio server.

Clearing Revu Client Project Cache

Several circumstances may cause a user’s Project cache to become corrupted and need to be cleared. Below are steps 
on how to accomplish this.

In Revu, go to the Project in question and confirm you have no files currently checked out.
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If no files are checked out, log out of Studio and go to the following path on your computer, depending on your version:

%localappdata%\Bluebeam (If using Revu 2015-2017)
%localappdata%\Revu (If using Revu 2018)
%localappdata%\Revu\data\ (If using Revu 2019 and above)

Once you’re there:
1. Find a folder named the same as the Project ID (xxx-xxx-xxx). 

Note: Because it’s on a Studio Enterprise server, the location is not standard. Search this location for a folder of 
that name or go into each "0X" folder until you find it.

2. Rename the folder that shows the Project ID in question (You can enter ”old” at the end of the new folder 
name).

3. Within Revu, log back into Studio. 
4. Go into the Project in question to verify the issue is resolved.

Note: When you log back into the Project, this cached folder is recreated with the data from the Project hosted on the 
Studio Server

“Unable to establish a secure connection” error when logging in

Problem
When attempting to log into Studio Enterprise through Revu, users receive an error stating “Unable to establish a secure 
connection to ‘YourStudioURL’”. 
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Solution
Use this support article to resolve issue. 

Trouble Logging in (User)

Problem
User unable to successfully log into the Studio Enterprise server from the Revu client.

Solution
Check the following:

• Confirm that the Studio Enterprise server name is correct.
• If your company uses Active Directory to connect to Studio Enterprise, be sure that the domain/email is correct. 

If your company doesn’t use Active Directory, enter the email address that’s associated with the user’s Studio 
account.

• If the user still cannot get in, select "Use Windows Authentication" and try logging in that way.
• Try logging into Studio Enterprise server via a browser: 

o Example: https://bluebeam.company.com
o If the user can log in here, this will help validate that your credentials are correct.

• Check Revu client logs on the user’s machine, look for errors in the revu.log.
• If the problem persists, an admin should check the Studio Portal to ensure the user’s Studio account is set up 

properly on the back end. For more information, see the User Administration and Reporting section.
• The user’s account password may need to be reset. For more information, see the Reset/Change Studio Account 

Password section.

Login Error:” Could not reach ‘YourStudioURL’ at this time. Would you like to work offline?”

Problem
When attempting to log into Studio Enterprise through Revu, users receive an error stating, could not reach 
“YourStudioURL” at this time. Would you like to work offline?”

https://support.bluebeam.com/articles/unable-to-establish-secure-connection-error/
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Solution
Please use this support article to resolve issue. 

Can't Finalize Session

Problem
Users are unable to finalize a Session. 

Solution
Check the following:

• If the user is running Revu 2015, update to a newer version.
• Check the logs for the end users’ Revu clients.
• Have the Session or Project owner ensure the end user has the needed permissions to perform the action.
• Can the user “Save As” or generate a Session Report?
• Test the process on a different user’s system to verify the issue is related to this specific Revu instance.
• Clear local Session cache (backup folders if there are changes that haven't been uploaded) and try again.
• Test the issue with a different Studio account to verify the issue is related to the account.
• Check Event Viewer & Studio Logs on Studio Enterprise Server.

Can't Upload or Download Files to or from Sessions/Projects

Problem
A user is unable to upload or download files to or from a Project and/or Session.
Solution
Check the following:

• Check the logs for the end user’s Revu client.
• Test the process on a different user’s system to verify the issue is related to this specific Revu instance.
• Clear the local Session and/or Project cache (back up folders if you have changes that haven't been uploaded) 

and try again.
• Test with a different Studio account to verify the issue is related to the account.
• Have the Session or Project owner ensure the end user has the needed permissions to perform action. 
• Check the Event Viewer and Studio Logs on the Studio Enterprise server.
• Determine if the Studio Enterprise server or the SQL server is out of disk space.
• Ensure the database is not full and is set to auto-expand.

Can’t Go Offline with Studio Enterprise

Problem
Users are unable to go into Offline mode while using Studio Enterprise.

Solution
The issue could be a case sensitivity issue with the user’s email address.

1. Ensure the user has no pending Session markups, or they will be lost, then close Revu.
2. Open the following location in File Explorer: 

%appdata%\Bluebeam Software\Revu\[year]
3. Rename the UserSettings.xml file.

https://support.bluebeam.com/articles/login-error-could-not-reach-yourstudiourl-at-this-time/
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4. Reset settings in Revu.
• Instructions on how to reset settings will change depending on Revu version. See this support article for the 

procedure.
• The reset settings option in Revu resets your settings to their original configurations. 

Note: Before proceeding, we recommend you back up your settings in case this reset doesn’t produced the 
desired result.

5. Reopen Revu and log into Studio again.

Error: “A validated e-mail address is required to login…”

Problem
The following message appears when trying to log into a Studio Project or Session:
“A validated e-mail address is required to login. A new validation e-mail has been sent.”

Solution
See this support article to resolve this issue.

Session Files in Studio Enterprise Fail to Download with Revu 2017.0.20

Problem
Users in organizations running Bluebeam Studio Enterprise are unable to download files from Studio Sessions with Revu 
2017.0.20.

Solution
Studio Session documents may not download successfully when using Revu/Vu version 2017.0.20 on Studio Enterprise. 
To resolve this issue update Revu to 2017.0.40 or newer. This issue is specific to 2017.0.20.

See this support article to resolve issue. 

Time Stamp Difference

When working in Sessions/Projects you may see different time stamps, which may be confusing if the Session/Project 
includes users in different time zones. Time stamps for markups are adjusted to reflect the time zone for each user’s 
Revu client. For example, a user in California will see a timestamp in Pacific Time for the markup left by a user in New 
York. However, reports will always reflect the time zone of the person who created the report.

In relation to the time stamps found in the Studio Portal, these will be based on the time zone in which the Studio 
Enterprise server is using.

https://support.bluebeam.com/articles/how-to-back-up-your-revu-2019-settings-stamps/
https://support.bluebeam.com/articles/error-a-validated-e-mail-address-is-required-to-login/
https://support.bluebeam.com/articles/session-files-in-studio-enterprise-fail-to-download-with-revu-2017-0-20/
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Error: “Method Not Allowed” Occurs While Creating a New Studio Session

Problem
When you create a new Session, the error "Method Not Allowed" displays, but the Session appears in the Studio Portal. 
When you log into this Session and add a document, you may notice that markups added to the document remain in the 
Pending status. This issue occurs because the unsupported feature WebDAV publishing is enabled on your application 
server.

Solution
To resolve this issue, remove WebDAV publishing from your Studio Enterprise application server. 

1. Open the Server Manager on the Studio Enterprise Windows application server.
2. On the upper right, select Manage > Remove Roles and Features, and click Next. 
3. Select Server Roles, scroll to find Web Server (IIS) > Web Server > Common HTTP Features and clear the 

WebDAV Publishing checkbox.
4. Select Next until you can select Remove on the Confirmation section.

Note: You may need to restart the server for the change to take effect.

How To…

Add a Studio Enterprise Server to Revu

1. In the Revu Studio tab, click the Studio drop-down and select Sign In… > Manage Servers.
2. In the Preferences dialog, select Studio.
3. Select the Servers tab. 
4. Select the “+” icon and add the Studio Enterprise Hostname. 
5. Select OK.
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Create User Accounts

To create an account on a server:
1. From the Revu Studio tab, click the Studio drop-down and select Sign In. 
2. Select the Studio Enterprise Server in question. 
3. In the Sign in window, select Create Account and provide your email and password.
4. Select OK. 

For more information, see this support article.

Change the Email Address Associated with a Studio Enterprise Account

You can change the email address associated with your Studio Enterprise account by opening a browser and entering 
the URL for your company Studio Enterprise server. 
Example: https://bluebeam.company.com

1. Sign in using your Studio account login information.
2. In the left navigation, select My Profile.
3. Select the Change Email tab.
4. Update your email address and confirm your password. 

Change Display (Default) Name

You can change your default name associated with your Studio Enterprise account by opening a browser and entering 
the URL for your company Studio Enterprise server. 
Example: https://bluebeam.company.com

1. Sign in using your Studio account login information.
2. in the left navigation, select My Profile.
3. Select the User Data tab.
4. Type a new Default Name. 
5. Select Update profile.

Note: The new default name won’t appear in your existing Studio Sessions or Projects. However, the default name will 
appear in any new Sessions or Projects you join. The change will take effect after you sign out of the Studio Enterprise 
application server and sign in again. 

https://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-or-vu
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Reset/Change Studio Account Password

If you want to reset the password for a Studio Enterprise account:

1. From the Revu Studio tab, click the Studio dropdown and select Sign In. 
2. Select the Studio Enterprise Server in question. 
3. Enter your email address.
4. Select Lost Password. 

You should then receive a password reset email. You can also change your Studio account password by opening a 
browser and entering the URL for your company Studio Enterprise server. 
Example: https://bluebeam.company.com

1. Sign in using your Studio account login information.
2. In the left navigation, select My Profile.
3. Select the Change Password tab. 
4. Update your password.
5. Select Change. 

If you don’t see the Change Password tab, you are likely using an AD account. See the Change Password Tab Missing 
from Studio Portal for Some Users section in this document for more information. 

If that does not help, determine whether you have AD integration with your Studio Enterprise server.  If so, try to log in 
both by checking the Windows Authentication box and without doing so. You can also try typing your 
"domain\username". If you still experience issues logging in, you may need to reset your AD account password.

Restoring Sessions

In most cases, you can restore a Session that hasn’t been purged from the database. 
You can restore a Session password by opening a browser and entering the URL for your company Studio Enterprise 
server. 
Example: https://bluebeam.company.com

Sign in using your Studio account login information. 
If you are the host of the Session, follow these steps:

1. In the left navigation, select My Sessions.
2. Select the Session you want to restore. 
3. Use the Status dropdown to select Active.
4. Select Update data.
5. Return to Revu to log out and log back into Studio. 

The Session should appear in your list again.

If you are not the host of the Session, a user with Administrator privileges in the Studio Portal can restore the Session via 
the Sessions tab in the portal. 

For more information, see this support article.

https://support.bluebeam.com/articles/how-to-reactivate-a-finalized-or-deleted-studio-session/
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Incompatible Features

Incompatible Feature – Not Joined tab for Sessions and Projects

The Not Joined feature introduced with the initial release of Revu 20 is not compatible with Studio Enterprise. Revu will 
behave the same as it did in previous versions, where you only have access to the Joined list of Sessions/Projects. The 
Not Joined tab, as seen below, won’t be visible when connected to Studio Enterprise. 

Incompatible Feature – Reassign Session Markup Ownership

The Revu 20.1 feature that allows you to securely reassign markup ownership when a collaborator permanently leaves a 
Session is not compatible with Studio Enterprise. Instead, Revu will behave as it did in previous versions. When you 
select “Deny” for an attendee, the following window won’t appear.

Incompatible Feature — Flatten when creating Share Link to Project File

If you select the Share Link... option for a Project file in Studio Enterprise, the Flatten option will not be available. If you 
want to share a flattened PDF from a Project, you will need to first manually run a Flatten (Ctrl+Shift+M) operation on it.
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Incompatible Feature — Major/Minor Version selection when Checking In Project Files

Studio Enterprise doesn’t allow you to select whether the changes to a file are Major or Minor version changes when 
checking in a Project file. 
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Incompatible Feature - Update Project Copy from Session 

Studio Enterprise doesn’t allow you to update a Project Copy from a file that is checked out to a Session. If you need to 
update the Project Copy, you will need to Finish the Session > Overwrite Existing Files > and then check the files back in. 
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Miscellaneous Issues

SMTP Email Server Issues

Problem
Studio emails are not successfully sent to users outside their network.

Solution 
Check the following:

• Log into the Studio Portal with an administrator account and check the E-mails tab.
o When Studio emails are successfully sent from the server, the status code for that e-mail in the Studio 

Web Portal is "200".
o When the status code for an e-mail reads "999", the e-mail wasn't successfully sent.
o All email statuses:

▪ 0 = Pending
▪ 100 = Sending
▪ 200 = Sent
▪ 999 = Error

• If a “999” error occurs and the Studio Enterprise administrator has set up their email client with 
Microsoft Exchange, check the "Externally Secured (for example, with IPsec)" option in the Exchange 
Management Console.
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• Other Issues:
o Reference SMTP sections in the Studio Enterprise Installation and Configuration Guide.
o Ensure all settings in the E-Mailer Service panel of the Bluebeam Studio Enterprise Administrator are 

valid:
▪ Verify SMTP FQDN is valid and allows connections.
▪ Ensure the port is valid and open.
▪ Ensure the service account username is valid.
▪ Ensure the associated password is correct and not expired.
▪ Ensure e-mail and reply to e-mails addresses are valid. 
▪ Test with and without Enable SSL checked.

o Send test e-mail in the E-Mailer Service panel.
o Ensure Enable E-mail Notifications is selected in E-Mailer Service panel.
o If you search the internet you can find web-based SMTP test tools. You can use one of these tools from 

the SE server to test the connection and troubleshoot.
o Check JobQueue.log for the following errors: 

▪ “Authentication failed because the remote party as close the transport system”. This error may 
be due to the changes on the SMTP server to only allow TLS 1.2 or newer. TLS 1.2 should be set 
as the default for the application server, with TLS 1.0 and TLS 1.1 being disabled. For more 
information, see https://businesswintelligence.com/content/108/office-365-remote-party-
closed-transport-stream.

▪ "ERROR Bluebeam.Studio.JobQueue.EmailerScheduledOperation — Unhandled exception 
System.Net.Mail.SmtpException: Server does not support secure connections." This error tends 
to occur when you have TLS 1.2 enabled on the server and have the Enable SSL option selected 
in the E-mailer Service section of the Bluebeam Studio Enterprise Administrator. To resolve the 
issue, please deselect Enable SSL in the Bluebeam Studio Enterprise Administrator.

o Ensure the Microsoft Messaging Queuing (MSMQ), Bluebeam Studio Job Queue, and Bluebeam Studio 
Services are all running.

• E-mailer Service settings example:

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://businesswintelligence.com/content/108/office-365-remote-party-closed-transport-stream
https://businesswintelligence.com/content/108/office-365-remote-party-closed-transport-stream
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Slow Performance When Invitations or Notifications are Sent
Check the JobQueueService.log for the error, “Message submission rate for this client has exceeded the configured 
limit”. This error is a result of a MessageRateLimit being set on the SMTP server in question. You should remove the limit 
or use an SMTP server that does not have this limit set. For more information, see 
https://www.servolutions.com/support/articles/messagesubmissionrate.htm.

Maximum File Upload Size

By default, the maximum upload size of a document is 1GB. It is possible to increase this value from 1GB to the 
maximum possible upload size of 1.99GB. As a result, large files are unable to upload while smaller files upload 
successfully.

The current limitation is due to the following reasons:
• In Revu, the HTTP client used to send requests to the server has a default limit of 2 GB within the code (on the 

Microsoft side) that limits file sizes that are read into memory before being sent.
• The current Studio Enterprise file upload implementation attempts to load the entire file into memory before 

saving it to the Studio database.
• Due to the IIS request size implementation, the content of each web request can only be a maximum 

of 1.99 GB. This maximum impacts all files uploaded.

To increase the upload file size from the current limit of 1 GB to 1.99 GB:
1. Connect to the Studio Enterprise 3.2 server.
2. Go to the directory: C:\Program Files\Bluebeam Software\Studio\API.
3. Run a text editor as an Administrator and open the Web.config file in that directory and locate the following 

block of XML:

https://www.servolutions.com/support/articles/messagesubmissionrate.htm
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                                                  Max Request Length & Content Length

<system.web>
    <compilation targetFramework="4.5" />
    <httpRuntime targetFramework="4.5" maxRequestLength="2097151" />
</system.web>
<system.webServer>
    <security>
        <requestFiltering>
            <requestLimits maxAllowedContentLength="2147483647" />
        </requestFiltering>
    </security>
</system.webServer>

4. Change the current values of the maxRequestLength and maxAllowedContentLength to the values shown 
above.
WARNING:  These are the only values that should be modified within this file. Modifying any other values may 
cause significant/unforeseen problems.

5. Save the changes.
6. Restart the Bluebeam Studio Server IIS Site.

 
After this change, you will be able to upload up to 1.99 GB files to Studio Projects. 

Note: If a file does not exceed the file limit and still fails to upload, it may be timing out. If a transfer takes 90 seconds or 
more, it may be timing out. To address this issue, ensure file transfer speeds are adequate. 

Bluebeam Server (Services) Fail to Restart

Problem
The Bluebeam Services (Bluebeam Studio Job Queue & Bluebeam Studio Services) are failing to start. They may move 
into a starting state, but they never move to a running state. 
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Solution
Check the following: 

• Attempt to restart the Bluebeam Services.
1. Log into the Bluebeam Studio Enterprise portal. 
2. Select Tools > Restart Server.

Note: If restarting fails, try a few more times. It sometimes takes 2-3 attempts to successfully restart.
• Make sure the license or trial is still valid or not expired. Restart the services using the steps above.
• Check to make sure the certificate used is still valid. 

1. Log into the Studio Enterprise portal.
2. Go to Certificate Configuration > Change Certificate. 
3. Select the current certificate for the server, then restart the services.

If you receive the error, “Could not find certificate that matches the Certificate Hash", the certificate may need 
to be updated, or you can follow the steps in the Studio Sessions Markups are Not Updating in Real Time 
section of this document.
Note: The server's certificate needs to be installed under Personal Certificates (NOT Trusted Root) as this is the 
Digital ID for the server.

• Ensure that the IIS web site Binding is configured to use the correct certificate. For more information, see the 
Certificate Change section of this document. 

• If services continue to fail, check the Studio log files and the Event Viewer for errors and additional information. 
o While normally benign, the following error may prevent your server from restarting: [Server Thread] 

WARN Bluebeam.Studio.Collaboration.CServer - Could not find preferred IP address 0.0.0.0, will use first 
available IP.

o In this case ensure an IP Addressed is assigned in the Port 443 binding for the Bluebeam Studio Server 
site in IIS. Perform an IISRESET after this change.

o The Event Viewer may point to an issue where a Settings.xml file cannot be found. This file is located in 
C:\ProgramData\Bluebeam Software\Studio. If there is a backup of a valid Settings.xml file in this 
location, rename it to “settings.xml”.

• Ensure Services are set to auto-restart. This process can be found in the Studio Server Trial Expired Error in Revu 
When Trying to Login section.

• If all else fails, this can be resolved by reinstalling Studio Enterprise. 

“Error Reading Settings.XML” error when opening Bluebeam Studio Administrator on 
Studio Enterprise Server

Problem
The “Error Reading Settings.XML” message appears when you open Bluebeam Studio Administrator on the Studio 
Enterprise server. Users may be unable to connect from Revu.
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Solution
Check the following:

• Check the Windows Event Viewer for errors. 
o We have seen SQL exceptions indicating that the password for the service account expired. Updating 

the password resolved the issue.
o The issue could also be that the SQL server is not responding or the SQL Server service is not 

running. Ensure the SQL server is running and reachable.
• An invalid value set may exist in the T_Configuration Table. If any changes were made to this table, roll back 

those changes.
• If you have a backup of a valid Settings.xml file, make a copy of the current Settings.xml and replace it with the 

backup. The Settings.xml file is located C:\ProgramData\Bluebeam Software\Studio on the Studio Enterprise 
server. 

• If all else fails, reinstall Studio Enterprise.
Note: If the performance patch has been implemented, update the Settings.xml file with the Max Pool Size value 
set to 1024. As well as updated API files uploaded to C:\Program Files\Bluebeam Software\Studio\API. 

IIS Worker Process Using All (or most) of the CPU

Problem
The IIS worker process is using all (or most) of the CPU.

Solution
Windows Update may have a pending required reboot. Reboot the server and ensure updates are completed. 

Users Cannot Create Sessions and/or Cannot Create Projects

Problem
Users are unable to create Studio Sessions and/or Projects in the Studio Enterprise environment.

Solution
• Verify the Users properties and the Server Permissions page within the Studio Enterprise portal. 

In the Users section, search for a user who is experiencing this behavior. Ensure they have Server Access set to 
“Allowed”. Restricted access will not allow them to access the Studio Enterprise server. The Create Session or 
Create Project settings will both keep the user from creating the respective object. If the user needs that 
function, ensure it is set to “Allowed” and that “Update profile” is selected. The following image illustrates a 
user who can’t create Sessions but can create Projects.
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For more information, see the Studio Enterprise Installation & Configuration Guide.
• If the Revu clients are 2016 or below, they may be unable to create Sessions due to the TLS version enabled. If 

this is the case, reference the TLS Issue – Unable to Connect Using Revu 2016 and Older section of this 
document.

• Check Studio Enterprise Administrator > Status and verify an IP address appears in the Hostname field. If so, 
change the hostname to the server FQDN. You must restart the server for the change to take effect. 

• Verify if the BluebeamCache database exists on the SQL server.

Add Studio Enterprise Server to All Users — RevuPreferences.xml

You can use the Bluebeam Administrator command line to deploy a modified RevuPreferences.xml file that merges only 
the server settings to the users while preserving all other preferences. 

To do so, use a text editor to open the RevuPreferences.xml file and add the following line to the beginning of the 
filebefore staging it for deployment:
Merge=”True”

Example header:
<RevuPreferenceDictionary Version="1" Merge="True">

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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After you perform this task, we recommend that you delete all other settings that you don’t want to change. 

Example: 

<?xml version="1.0" encoding="utf-8"?>

<RevuPreferenceDictionary Version="1" Merge="True">

  <Studio>

    <Force.Proxy>False</Force.Proxy>

    

<ServerCache>{"Servers":[{"ServerURL":"studio.bluebeam.com","ServerEmail":"","ServerPassword":"","ServerUserName":"","RequestedAuthMode":0},{"ServerURL":"StudioEnterpr

ise.example.local","ServerEmail":"","ServerPassword":"","ServerUserName":"","RequestedAuthMode":0}],"Active":{"ServerURL":"studio.bluebeam.com","ServerEmail":"","ServerP

assword":"","ServerUserName":"","RequestedAuthMode":0}}</ServerCache>

    <ShowAgreementScreen>False</ShowAgreementScreen>

    <Toolbar.Integration.Only>False</Toolbar.Integration.Only>

    <URL>studio.bluebeam.com</URL>

  </Studio>

</RevuPreferenceDictionary>

To deploy the modified file, see the Bluebeam Revu 20 Deployment Guide or the Bluebeam Revu 21 Deployment Guide 
(depending on your version of Revu). 

Note: Any sections specified in the merged XML file will overwrite those currently present. For example if a user has 
studio.bluebeam.com and server1.company.local present and the merge file only has a new server 
(server2.company.local) specified, the user will only have the new server after the merge. If other servers are needed, 
they will need to be specified in the merge preferences file.

You can also force the users to use certain Studio Servers. Doing so, however, disables the Manage Servers dialog box in 
Preferences. For more information, see the Server Whitelist section.

Server Whitelist – Force Allowed Studio Servers

Problem
If you use RevuPreferences.xml to set the default Studio server to your Studio Enterprise server, users may have their 
User overwritten with a default copy that reverts the server back to the default Studio server. This issue could occur 
because of a settings reset. 

https://support.bluebeam.com/articles/bluebeam-revu-deployment-guide-version-20/
https://support.bluebeam.com/articles/bluebeam-revu-deployment-guide-version-21/
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Solution 
You can change the Studio Whitelist registry key to force users to use only specified Studio servers. 

1. Run the Windows Registry Editor as an Administrator.
2. Navigate to “Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Bluebeam Software”.
3. Right-click the Revu version number, then select New > Key.
4. Name the new key “Studio”.
5. Right-click Studio then select New > String Value.
6. Name the string value “AllowedServers”.
7. Right click “AllowedServers” then select Modify. 
8. In the Value data field, type the desired server name.
9. Select OK. 
10. Close and reopen Revu.

Note: After you make this change, users will not be able to add/delete servers under the Manage Servers section of 
Studio which should keep this server locked in for you. 

For more information, see this support article. 

User Not Receiving Session Alerts or Seeing Markups

Problem
Session users are not seeing new markups or receiving alerts.

Solution
Ensure the Microsoft Message Queuing (MSMQ) service is running on the Studio Enterprise server. If messaging 
queueing has crashed, users will not be alerted or be able to see markups. If you wish to set the MSMQ service to auto 
recover, reference the Studio Server Trial Expired Error in Revu When Trying to Login section.

Migrating Studio Enterprise Data to Public Studio Servers

We don’t currently have an automated process to migrate Studio Enterprise Sessions and Projects to our public Studio 
servers (studio.bluebeam.com, bluebeamstudio.co.uk, etc.), but you can follow our recommended manual procedures. 

Note: If you wish to know more about our public Studio server offerings, please see the support article Bluebeam Studio 
Regions, or reach out to Sales at sales@bluebeam.com or your Account Manager.

Sessions
1. Finish all current Sessions on Studio Enterprise and save the files.
2. Start new Sessions in Cloud and upload new files.
Note: When you upload a document into a new Session, the markups in the document at that time will become locked 
and you can no longer modify markups. You should not migrate Sessions on Studio Enterprise to Sessions on the Studio 
public server unless you no longer need to modify those markups. 

https://support.bluebeam.com/articles/studio-whitelist-control-server-access-and-force-windows-authentication/
https://support.bluebeam.com/articles/changing-your-studio-region/
https://support.bluebeam.com/articles/changing-your-studio-region/
mailto:sales@bluebeam.com
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Projects
1. Download a copy of existing Projects on Studio Enterprise.

a. When in the Project, right-click the root level. 
b. Select Download Copy. 

2. Create new Projects on the public Studio server.
3. Upload a copy of the Project to the public Studio server.

If you are only archiving this data and will not be uploading it to the public Studio server, you can skip the last two 
steps.

Note: If you are downloading Projects larger than 50 GB and encounter issues with the download process, you may want 
to avoid downloading the Project from the root level. Instead, download the folders below the root level. To learn the 
Project size, see the General tab in Project Settings.

We created some helpful queries that may help in the transition. Use this download link for scripts. 
Password: SEsupport123

Scripts available for download: 
• ReportActiveProjects.txt - This script is used to report all active Projects, so you can verify which Projects need to 

be migrated. You can use the Portal to see which Sessions are active.
• ReportActiveSessions.txt - This script is used to report all active Sessions, so you can verify which Sessions need to 

be migrated. You can also use the Portal to see which Sessions are active.
• Unrestrict Projects.txt - This script can change a Project from Restricted to Unrestricted and allow users access to a 

Project that was Restricted to download files.
• DisableCreateSessionProjects.txt - This script will disable a user’s ability to create Projects/Sessions. The script 

includes comments to help apply the script to all users or restrict access to the Studio Enterprise server as a whole. 
This is a good script to run after everything has been moved to the cloud, and you want users to start using that 
instead.

Does Studio Enterprise support SAML Authentication?
Studio Enterprise supports LDAP connections for single sign-on.

Two-factor Authentication (2FA)

Studio Enterprise does not support 2FA, only Windows Authentication with LDAP.

Encryption

Document encryption occurs between the Revu client and the Studio Enterprise web server over SSL/TLS using port 443 
while in transit. Documents are not encrypted in the users’ local Studio caches on their local machines.

By default, documents are not encrypted in the SQL database; all docs live in the DB as binary blobs. You can enable 
encryption at the SQL Server level. However, this is not related to Bluebeam, but is specific to the SQL server. A skilled 
DBA will need to be involved if you chose to enable this. For more information about SQL Server encryption, see  can be 
found via Microsoft SQL Documentation.

https://studio.bluebeam.com/share/dgjnby
https://docs.microsoft.com/en-us/sql/relational-databases/security/encryption/sql-server-encryption?view=sql-server-ver15
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Customizing Email Templates

To customize email templates: 
1. Log into your Studio Enterprise portal (by entering your Studio server name into a web browser).
2. On the left, click E-mail Templates. 
3. Click one of the templates on the right of the window to customize it using HTML. 

Note: While you can edit them individually, there is not a way to disable one and keep the rest enabled. 

If you want to disable all email notifications:
1. Open the Studio Enterprise Administrator application.
2. In the left navigation, select E-mailer Service.
3. Deselect "Enable E-mail Notifications". 

Session Archiving/Deletion/Purging

The following images display the default values for the Session Manager Service and the Job Queue Service, as detailed 
in the Studio Enterprise Installation and Configuration Guide. 

If these values are set, Sessions with no activity for 90 days will be moved from an Active state into an Archived state. 
That Session will remain in an Archived state for 180 days before it is moved into a Deleted state. Sessions that are 
manually Finished in Revu will also be moved into a Deleted state. Sessions in an Archived or Deleted state are 
still recoverable by the Session host or Studio Administrator by logging into Studio web portal, selecting the Session 
owner’s account, then My Sessions, and finally double-clicking the Session to recover and set the Status value to Active.

The "Days to Retain Deleted Sessions" value on the Job Queue Service page comes into effect when Sessions are in 
a Deleted state. Using the values present above, Sessions in a Deleted state will be held for 30 days before being Purged. 
Once a Session is Purged, it is no longer recoverable. When Sessions meet the criteria, all Sessions will be purged in 
accordance with the “Check every” value. 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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The "Days to Retain Deleted Sessions" value in the Job Queue Service page also applies to documents in Sessions that 
have been deleted. For example, if a document has been deleted from a Session, but the Session is still in an Active or 
Archived state, that document will still be purged as a result of the Job Queue policy. If a document is deleted from an 
active Session, and the Days to Retain value is 30 days, that document will be purged after 30 days even though the 
Session is active.

Project Purging

Enable Projects Data Purge — Controls whether deleted Projects are eventually purged.
Purge deleted Projects — Specifies when Projects are purged after deletion.
Purge deleted Project items — Controls when files and folders are purged after their parent Project has been deleted.

Enable Projects File Revision Management — Determines whether file revisions are retained.
Maintain a maximum of — Sets the maximum number of retained file revisions.
Note: Versions older than the maximum are automatically purged, and some actions – such as moving or “undeleting” 
files – are tracked in their revision histories, but don’t count as revisions.

The “Project Data Purge” service setting is disabled by default.

Note: Be sure your SQL server has sufficient hard drive space to hold all your Studio Projects.

When the standard Project purge service is active, it will delete 100 Project items every hour. It doesn’t constantly purge 
in the background. If the purge service is off and is re-enabled, the service won’t perform a big purge operation. Sessions 
use a different process where it will purge all deleted Sessions that match criteria.
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